
LESSON 1 Advanced Data Organization, Lesson Opener, p.3 

 21st Century Skills Answers will vary. Students should describe a skill they recently 
learned well by practicing. 

 

LESSON 1 Reading Guide, p. 4 
See page TM42 of the Teacher Annotated Edition for English Language Learner 

activity suggestions.  

 

EXERCISE 1-1 Create and Modify List Ranges, p. 5 

Step-By-Step Tip In Step 3, explain to students that if the selected range contains data 

that they want to display as table headers (as in this Exercise), they should check the My 

table headers check box.  

 

EXERCISE 1-1 Create and Modify List Ranges, p. 6 

Step-By-Step Tip In Step 18, note that the table displays only the items sold at all concert 

dates above the average sale made at all concert dates. 

 

EXERCISE 1-2 Use Advanced Filters, p. 7 

Step-By-Step Tip In Step 7, point out to students that the row numbers of filtered data are 

blue to show that a filter has been applied and that all data may not be visible. 

 

EXERCISE 1-3 Create Subtotals, p. 8 

Teaching Tip Tell students that they can put page breaks between the groups of items 

that are subtotaled by clicking Page Break between groups in the Subtotal dialog box.  



EXERCISE 1-4 Group and Outline Data, p. 9 

English Learners Make sure English Language Learners understand the meaning of the 

word outline. An outline lays out information in a sequential or hierarchical order. 

 

EXERCISE 1-5 Apply Data Validation Criteria (Continued), p. 11 

Teaching Tip Explain to students that the width of the drop-down list is determined by 
the width of the cell that has the data validation and that they may want to adjust the 
width so that the entries are not wider than the width of the drop-down list.  

 

EXERCISE 1-7 Remove Duplicate Values, p. 13 

Troubleshooting Explain to students that the Remove Duplicate Values feature 
permanently deletes data and that it is a good idea to copy the original range of cells or 
table to another worksheet or workbook before removing the duplicate values. 

Step-By-Step Tip In Step 5, tell students that if there are no duplicate values in the range 
of cells or table, the message will indicate that no duplicate values were removed. 

 

EXERCISE 1-8 Use the Evaluate Formula Feature, p. 14 
Teaching Tip Explain to students that if a cell reference is blank, a zero value (0) is 
displayed in the Evaluation dialog box. 

 

EXERCISE 1-9 Name a Cell Range, p. 15 

Differentiated Instruction/Advanced Students Tell advanced students that a name can 
be used anywhere within a workbook. Therefore, using names makes it easy to refer to a 
call or range on another sheet. 

Step-By-Step Tip In Step 8, if the word total does not appear in the Name box, have 
students key the word. 

 



EXERCISE 1-11 Modify and Delete a Named Cell Range, p. 17 

Intervention Strategy Before beginning this exercise, you may want to review with the 
class how to find percent of total. To find out what percent of $9,250 $350 is, students 
would use this equation: 350 ÷ 9,250 = .0378. They should then move the decimal two 
spaces to the right and round up to reach the value 3.8%. 

Troubleshooting Explain to students that the Close button only closes the Name 
Manager dialog box. It is not required to click Close to commit changes that they have 
made. 

 

EXERCISE 1-12 Merge and Split Cells in a Range, p. 18 

Solution Use the file Blues-SF.xlsx as a solution file for Exercise 1-1 through Exercise 
1-12. 



21st Century WORKPLACE Feature, Making Complex Choices, p. 19 

SkillBuilder Answers  
1. In making her decision, Sarah must consider the factors of doing more homework, 
getting into college, trying out for the school play, and working her after-school job. 

2. Answers will vary. Students may respond that Children’s Book Shop has decided not 
to carry a popular book they feel is of low quality. Another decision has been to stock just 
two copies of a popular book and let customers choose for themselves. 

3. Answers will vary. Students should describe their decision-making process, including 
the factors they considered, and say whether or not they would make the same choice 
again. 

 



LESSON 1 After You Read, p. 20 

Answers to Review Vocabulary 

Complete the following statements on a separate piece of paper. Choose from the 
Vocabulary list on the left to complete the statements. 

1. If you create a table from a list of items you can [convert], or change, the table back to 
a normal range of data. (p. 5)  

2. When you use an advanced filter, only those items in a range of cells or table that meet 
certain [criteria] will be displayed. (p. 7)  

3. A(n) [name] can be used in a formula in the same way as a conventional cell 
reference. (p. 15) name 

4. To control the type of data entered into cells, apply [data validation]. (p. 10)  

5. A(n) [duplicate value] is when all values in a row are an exact match of all the values 
in another row. (p. 13) 

Answer to Vocabulary Activity Students makes flash cards for each of the vocabulary 
words in this lesson. Students use the flash cards to review the vocabulary words and 
their definitions. 

 

Answers to Review Key Concepts 

7. When you use an advanced filter, what happens to data that does not meet the criteria 
you set? (p. 7) 

A. It is displayed dimly. 

[B. It is temporarily hidden.] 

C. It is deleted. 

D. Its value is changed. 

8. What is the total of a group of items within a larger set of items? (p. 8) 

[A. subtotal] 

B. grand total 

C. AutoSum 

D. total 

9. Which of the following tools identifies inaccurate data? (p. 12) 

A. data validation 

B. Group and Outline Data 

[C. Circle Invalid Data] 

D. Evaluate Formula 

10. What does Evaluate Formula do? (p. 14) 

A. points to possible sources of an 
error 

B. displays tracer arrows 

[C. steps through a calculation] 

D. displays an explanation of an 
error 



LESSON 1 PRACTICE IT ACTIVITIES 

1. Create a List and Use Advanced Filters, p. 21 
Solution The solution for this file activity is Jobs1-SF.xlsx. 

2. Create Subtotals and Group and Outline Data, p. 22 
New Student Strategy If a student did not complete Practice Activity 1, then the solution 
file for that activity can be used as a data file for this activity. 

Solution The solution for this file activity is Jobs2-SF.xlsx. 

3. Circle Invalid Data and Use Data Validation, p. 23 
New Student Strategy If a student did not complete Practice Activity 2, then the solution 
file for that activity can be used as a data file for this activity. 

Solution The solution for this file activity is Budget3-SF.xlsx. 

 

LESSON 1 You Try It Activities 

4. Evaluate Formulas, p. 24 
Solution The solution for this file activity is Budget4-SF.xlsx.  

5. Name a Cell Range, p. 25 
Solution The solution for this file activity is Budget5-SF. 

 

LESSON 1 Critical Thinking Activities, p. 26 

6. Beyond the Classroom Activity The solution for this file activity is Refreshments6-
SF.xlsx. 

7. Standards at Work Activity Students’ files will vary but should include names in the 
following cells: B3:B14, C3:C14, C18, and C19. 

NCTM/Math (Number and Operations) Remind students that the names they choose 
should meaningfully describe the information in the cells or ranges. Ask students to 
explain why they chose the names in their five examples. Have them share their examples 
with the class. 

NCLB/Language Arts (NCTE 5) Students should understand that they need to consider 
the user as they create spreadsheets. Part of this consideration should include making 
certain that the spreadsheet makes sense and is easy to understand. 

8. 21st Century Skills Activity The solution for this file activity is Merchandise8-SF. 
Students should identify the 13 duplicate values in cell F3. Students’ answers in F4 will 
vary, but should include descriptions of how to use at least two other Excel tools to 
correct or prevent errors in data. 



LESSON 1 Challenge Yourself Projects, p. 27 

9 Organize a Donations Workbook  
LEVEL This is an intermediate level project. 

Solution The solution file for Project 9 is Zoo9-SF.xlsx. 
 

10 Monitor Donation Totals  
LEVEL This is an intermediate level project. 

Solution The solution file for Project 10 is Zoo10-SF.xlsx. 

 

11 Analyze Donations Data  
LEVEL This is an advanced level project. 

Solution The solution file for Project 11 is Zoo11-SF.xlsx. 

 

NCTM/Math (Number and Operations) Have students explore using different criteria 
to understand how data validation can be used to control the type of data that is entered 
into cells. For example, ask students to imagine that they have a spreadsheet with more 
than a thousand contributions. Students would choose to circle invalid data so that it is 
easier to make sure the whole spreadsheet is accurate. 

Answers Rubrics for each Challenge Yourself Project and the Before You Begin 
questions are available at glencoe.com. You may want to download the rubrics and make 
them available to students as they complete each project. 



LESSON 2 Advanced Data Analysis, Lesson Opener, p. 28 

 21st Century Skills Answers will vary. Students should describe a recent situation in 
which they had to make a difficult decision. 

 

LESSON 2 Reading Guide, p. 29 
See page TM42 of the Teacher Annotated Edition for English Learner activity 

suggestions.  

 

EXERCISE 2-1 Create PivotTable with PivotChart Reports, p. 30 
NCLB/Math (Number and Operations) Reinforce the representation of data as a chart, 
graph, or diagram as an effective tool to visually convey information by having students 
go online to find examples to share with the class. 

Teaching Tip Explain to students that if they drag a field to the wrong location in a 
PivotTable, they can just drag the field to a blank area of the worksheet. This will remove 
the field so they can try again. Also, remind students to be sure not to accidentally drag 
Concert Date into the PivotTable merely because it is the first item in the PivotTable 
Field List. Tell students to click the Undo button if they make a mistake. 
 
EXERCISE 2-1 Create PivotTable with PivotChart Reports (Continued), p. 31 
Step-By-Step Tip In Step 9, point out that the Sales field changes to Sum of Sales when 
it is droppped in the Values box. 
Differentiated Instruction/Advanced Students Encourage advanced students to click 
Change Chart Type in the Type group (on the Design tab) and select a different type of 
column or bar chart. 

 

EXERCISE 2-2 Modify Text Formatting Using Formulas, p. 32  
Teaching Tip Explain to students that formatting and modifying text using a formula is 
most helpful when working with a long list of repeated items, such as a large spreadsheet 
of orders being filled, a hospital’s list of patients grouped by insurance company, or a 
spreadsheet containing book titles that includes repeated publisher contact information. 

Step By-Step Tip In Step 5, explain to students that PROPER capitalizes the first letter 
in a text string and any other letters in text that follow any character other than a letter. All 
other letters are converted to lowercase. 



EXERCISE 2-3 Modify Text Content Using Formulas, p. 33 
Step-By-Step Tip In Step 1, remind students how to show hidden sheet tabs. 
Step-By-Step Tip In Step 3, explain to students that the formula they keyed removed the 
ADV- because they did not enter text between the two apostrophes. 

Differentiated Instruction/Advanced Students Encourage advanced students to create 
and use a formula in column E that substitutes PRINT for the promotion codes that contain 
PUB. Ask them to explain what they did differently. 

 

EXERCISE 2-4 Use the What-If Analysis Tool to Create Scenarios  
(Continued), p. 35 
Teaching Tip Ask students for examples of other scenarios that they could have added to 
the list. 
 

EXERCISE 2-4 Use the What-If Analysis Tool to Create Scenarios 
(Continued), p. 36 

NCLB/Math (Number and Operations) Have students write out the numbers in the 
formula for cells B15 and C6 for both scenarios.  

Teaching Tip Point out to students that they can switch between scenarios without 
closing the Scenario Manager dialog box. 

 

EXERCISE 2-5 Use the Solver Add-In, p. 37 
Intervention Strategy If Solver already appears on their Add-Ins tab, students can skip 
Step 1 and start with Step 2. 
NCLB/Math (Number and Operations) Have students run the Solver using different 
percentages. Ask students to translate the percentages into the proper decimal format. 
Show students what happens when a percentage that is greater than 100% is used.  

 
EXERCISE 2-5 Use the Solver Add-in (Continued), p. 38 
NCLB/Language Arts (NCTE 3) Student answers to the Academic Skills minifeature 
will vary. Students should demonstrate an understanding of advertising methods and 
target audiences. 
Teaching Tip Remind students that they can use the name total here to reference cell 
B14 because they named the cell in an earlier exercise. 

 

EXERCISE 2-6 Use SUMIF and SUMIFS in a Formula, p. 39 
Step-By-Step Tip In Step 7, point out to students that the only advertising method that 
meets both criteria in the SUMIFS function is bumper stickers. 



English Learners If English Language Learners have trouble following the steps, pair 
them with native English speakers. 
 

EXERCISE 2-8 Use AVERAGEIF and AVERAGEIFS in a Formula, p. 41 
NCTM/Math (Number and Operations) Reinforce the importance of database 
functions by asking students to explain the difference between a COUNTIF and an 
AVERAGEIF function. Ask them to come up with examples of the two to share with the 
class.  

Step-By-Step Tip In Step 8, point out to students that the only advertising method that 
met both criteria in the AVERAGEIFS function is posters. 

 

EXERCISE 2-9 Use Conditional Logic in a Formula, p. 42 
NCLB/Math (Connections) Reinforce using conditional logic by asking students to 
come up with examples of conditional logic that they use daily to make a decision. For 
example, 1) IF I study for a test now, THEN I will not have to study later. 2) IF I spend 
all my allowance on CDs, THEN I will not have enough money to go to a movie. 3) IF I 
stay up too late watching TV, THEN I will not wake up early. 4) IF I our team wins the 
game, THEN I will be happy. 

Step-By-Step Tip In Step 4, explain to students that the formula returned a FALSE 
result because 50 plus 100 equals 150.  

Step-By-Step Tip In Step 7, point out to students that Excel returned an ERROR result 
because the formula attempted to divide by C2, which is a blank cell. 

Teaching Tip Ask students for examples of other formulas that they could have added to 
the list. 
 

EXERCISE 2-10 Display and Print Formulas, p. 43 

Step-By-Step Tip In Step 1, make sure students key CTRL + ` (grave accent) and NOT 
the CTRL + ´ (apostrophe) . 

Step-By-Step Tip In Step 8, ask students to key data into the cells that contain the formula 
results. An error message appears that says the cells are protected and therefore read-only. 

Differentiated Instruction/Advanced Students Ask advanced students to go back and 
add a password in the Protect Worksheet dialog box. 

Troubleshooting Explain to students that when they prevent a formula from displaying 
in the Formula Bar, they also prevent the cells that contain the formula from being 
edited. 



EXERCISE 2-11 Use Lookup and Reference Functions, p. 44 
Step-By-Step Tip In Step 9, point out to students that they looked up values vertically by 
using an approximate match. Ask them to go back to the Cost of T-shirts tab to see that 
the quantity listed in A4 is 50, or the next largest value to 55. 

Inclusion Strategy Some students may find it easier to use the Insert Function button to 
create the formula. 

 

EXERCISE 2-11 Use Lookup and Reference Functions (Continued), p. 45 

Step-By-Step Tip In Step 18, point out to students that Excel looks up Quantity, in row 1, 
and returns a value from row 4 (50) that is in the same column. Explain to students that if 
row 1 had contained an actual number instead of the word quantity, and the formula also 
contained a number, Excel would have looked for an approximate match or the next largest 
value that is less than that figure. 

Solution Use the file Blues2-SF.xlsx as a solution file for Exercise 2-1 through Exercise 
2-12. 
 



Writing MATTERS Feature, Writing an Itinerary, p.46 
SkillBuilder Answers  

1. Answers may vary, but students should list at least four itinerary items, such as dates, 
times, transportation details, hotels, and meetings. 
2. Answers may vary, but students should recognize that itineraries help you know where 
you should be and when during a trip or tour. 
3. Answers will vary. Students may identify intineraries for tours of sports sites, gardens, 
or castles; visits to entertainmnet centers, etc. 
4. Students’ intineraries should be formatted as described in the feature and include at 
least three places for Mr. Clark’s class to visit, meals, and an evening activity. 
 
NCLB/Language Arts (NCTE 3) Be sure students understand that itineraries are meant 
to be functional documents. The purpose is to convey specific information about travel 
plans to travelers and other interested parties. As such, it should be clear, concise, and 
free of unnecessary information.  
 



LESSON 2 After You Read, p.47 

Answers to Review Vocabulary 

1. The [UPPER ] function will change the case of text in a cell or range of cells to capital 
letters. (p. 32)  

2. When you use the Solver, you can set a(n) [constraint], or limit. (p. 37)  

3. To test whether conditions are true or false and make logical comparisons between 
outcomes, use [conditional logic]. (p. 42)  

4. To test out a possible situation, use the [What-If Analysis] tool. (p. 34)  

5. A(n) [database] is a formula that acts only on cells that meet certain criteria. (p. 32) 
database function 

 
Answer to Vocabulary Activity Students makes flash cards for each of the vocabulary 
words in this lesson. Students use the flash cards to review the vocabulary words and 
their definitions.  

 

Answers to Review Key Concepts 

7. Which of the following displays and hides the formulas on a worksheet? (p. 43) 

A. CTRL + ‘ 

[B. CTRL + `] 

C. ALT + ~ 

D. ALT + ` 

8. What is the second argument of the LOOKUP function? (p. 44) 

[A. the LOOKUP table] 

B. the value in the worksheet you 
are looking for 

C. the row or column in the 
LOOKUP table that contains the 
value 

D. the database  

9. How do you perform a What-If Analysis? (p. 34) 

A. create a PivotChart 

B. group and outline data 

C. trace errors 

[D. compare scenarios] 

10. What does the SUMIFS function do? (p. 39) 

A. returns the average of all the 
cells in a range that meet a given 
criteria 

B. adds all numbers in a range of 
cells, based on a given criteria 

[C. add values in a range based 
on multiple conditions] 

D. averages cells that meet 
multiple criteria 



LESSON 2 Practice It Activities 

1. Create a PivotTable and a PivotChart, p. 48 
Solution The solution for this file activity is Jobs-PivotChart1-SF.xlsx. 

2. Use a Name and a SUMIF in a Formula, p. 49 
Solution The solution for this file activity is Budget-Names2-SF.xlsx. 

3. Create Scenarios, p. 50 
New Student Strategy If a student did not complete Practice Activity 2, then the solution 
file for that activity can be used as a data file for this activity. 

Solution The solution for this file activity is Budget-Scenario3-SF.xlsx. 

 

LESSON 2 YOU TRY IT ACTIVITIES 

4. Perform a What-If Analysis, p. 51 
New Student Strategy If a student did not complete Practice Activity 3, then the solution 
file for that activity can be used as a data file for this activity. 

Solution The solution file for this activity is Budget-Scenario4-SF.xlsx. 

5. Use AVERAGEIF and COUNTIF in a Formula, p. 52 
Solution The solution for this file activity is Tournament5-SF.xlsx. 
 

LESSON 2 Critical Thinking Activities, p. 53 
6. Beyond the Classroom Activity Students’ Tournament-6 files will vary but should 
include a PivotTable and PivotChart summarizing the fundraising data for the 
tournament, a chart title, and no legend.  

7. Standards at Work Students’ Tournament-7 files will vary but should include names 
for each column of fundraising data, and use a name in the formulas in the following 
cells: D4, D29, E4 .  

8. 21st Century Skills Activity The solution for this file activity is Bookstore8-SF.xlsx.  

Teaching Tip In the 21st Century Skills Activity, remind students to save the original 2 
percent as a separate What-If scenario so that they do not lose the information. 
 

LESSON 1 Challenge Yourself Projects, p. 54 

9. Monitor Price Changes  
 LEVEL This is an intermediate level project.  

 Solution The solution file for Project 9 is Bookstore9-SF.xlsx.  



10. Analyze Scenarios 
 LEVEL This is an intermediate level project.  

 Solution The solution file for Project 10 is Bookstore10-SF.xlsx.  

 

11. Analyze Price Increase 
 LEVEL This is an advanced level project.  

 The solution file for Project 11 is Bookstore11-SF.xlsx.  

 
Answers Rubrics for each Challenge Yourself Project and the Before You Begin 
questions are available at glencoe.com. You may want to download the rubrics and make 
them available to students as they complete each project. 



LESSON 3 Advanced Data Formatting, Lesson Opener, p.55 

 21st Century Skills Answers will vary. Students should identify a task in their 
schoolwork that would best be completed using Excel. 

 

LESSON 3 Reading Guide, p. 56 
See page TM42 of the Teacher Annotated Edition for English Learner activity 

suggestions.  

 

EXERCISE 3-1 Create a Custom Number Format, p. 57 
Intervention Strategy Check that students know where to locate and save their data 
files. 

Teaching Tip Tell students that a license plate number such as DJC 987 could be 
formatted using a custom format. Ask the students for other examples. 

 

EXERCISE 3-3 Use Conditional Formatting, p. 59  
Step-By-Step Tip In Step 2, point out to students that there is a difference between 
greater than and greater than or equal to. 

Step-By-Step Tip In Step 8, point out to students that the top 10 sales goals for 2010 are 
highlighted in green. 

Differentiated Instruction/Visually Impaired If students cannot see bright yellow, have 
them choose light grey. 

 

EXERCISE 3-3 Use Conditional Formatting (Continued), p. 60 
Teaching Tip Point out to students that a longer data bar represents a higher value. 

Step-By-Step Tip In Step 14, point out to students that the data is displayed with a two 
or three color gradient with the shade of the color representing the value in the cell. 

 

EXERCISE 3-4:- Use the Conditional Formatting Rules Manager, p.61 
Teaching Tip Explain to students that by default, new rules are added to the top of the 
list in the Conditional Formatting Rules Manager dialog box and therefore have a 
higher precedence. Tell students that they can use the Move Up and Move Down arrows 
in the dialog box to change the order of precedence. 

NCLB/Math (Number and Operations) Reinforce the representation of the concept of 
precedence by reviewing the order of operations in a mathematical operation with 
students. Point out to students, for example, that in an equation such as 3 + 4 x 5 = 5 x 4 



+ 3 = 23, multiplication has precedence over addition. Have students go online to find 
other examples of precedence to share with the class. 

Troubleshooting It may be helpful to tell students that manual formatting is not listed in 
the Conditional Formatting Rules Manager dialog box or used to determine 
precedence. 

 

EXERCISE 3-5 Insert and Modify a Graphic, p. 63 
Teaching Tip Explain to students that they can use the thumbnails in the drop-down 
menus to see how a formatting change will look before it is actually made to the picture. 

 

EXERCISE 3-5 Insert and Modify a Graphic (Continued), p. 64 
New Student Strategy If you have new students in class, this would be a good time to 
review creating drawing objects. 
NCLB/Language Arts (NCTE 3)Review the difference between contrast and brightness 
with students. Ask students to explain why they think changing the contrast of a graphic 
is more helpful than changing its brightness. Tell students that increasing the contrast 
makes light areas lighter and dark areas darker. Increasing the contrast can make it easier 
to see details in a graphic. 

 

EXERCISE 3-6 Scale a Graphic, p. 65 
Intervention Strategy It may be helpful to review percents with the class before this 
exercise. For example, review what it means to change the scale to 150 percent. 

 

EXERCISE 3-7 Rotate a Graphic, p. 66 
Teaching Tip Explain to sudent that the Align button allows them to align the edges of 
multiple selected objects, or center, or distribute them evenly across a page. 
 

EXERCISE 3-8 Apply Formats to Charts and Diagrams, p. 67 
Step-By-Step Tip In Step 5, after students click Close, point out that tick marks are 
added to the y axis every 1,000 units and that the numbers no longer have decimal places. 

 

EXERCISE 3-8 Apply Formats to Charts and Diagrams (Continued), p. 68 
Differentiated Instruction/Advanced Students If advanced students finish early, have 
them format other parts of the chart. 



 

EXERCISE 3-9 Apply Themes to Worksheets, p. 69 

Teaching Tip Explain to students that under Sample, they can see the effect of the 
changes that they make. 

Troubleshooting Point out to students that a ScreenTip tells them what theme is applied 
to their workbook.  

 

EXERCISE 3-9 Apply Themes to Worksheets (Continued), p. 70 
Solution Use the file Toys-SF.xlsx as a solution file for Exercises 3-1 through 3-9. 



Writing MATTERS Feature, How to Read a Technical Document, p. 71 

SkillBuilder Answers 
1. Answers will vary. Technical documents may include diagrams, headings, step-by-step 
instructions, and numbered or bulleted lists.  

2. Answers will vary. Students may say that one set of instructions was easier to 
understand than the other because it was better organized, had more detail, used clearer 
diagrams, etc. 

3. Answers will vary. Students may identify the following possible improvements: Have 
photographs instead of drawings to make the steps clearer, include more explanations of 
technical terms, number the steps, etc. 

 



LESSON 3 After You Read, p. 72 

Answers to Review Vocabulary 
1. Applying conditional formatting can help you see a [trend] in the numbers on a 

spreadsheet. (p. 59) 
2. [Scale] a graphic to change the size to a certain percent of its original size. (p. 65) 
3. [Conditional formatting] applies only to cells that meet certain conditions. (p. 59) 
4. The difference between lighter and darker areas of a graphic is called the [contrast]. 

(p. 63) 
5. To turn a graphic clockwise, [rotate] it. (p. 66) 
 

Answer to Key Term Activity Students use a graphic in a workbook to review the 
meaning of five vocabulary words in the lesson. Students manipulate the graphic to 
reflect the meaning of the vocabulary word written on a piece of paper. If students cannot 
remember what their term means, they review the term and then manipulate the graphic 
accordingly. 

 
Answers to Review Key Concepts 
7. Which custom format would display a value of 7987 as 7,987? (p. 58) 
A. 0,000 
B. *,*** 

[C. #,###] 
D. @,@@@ 

 
8. The Brightness button is found in which Picture Tools group? (p. 63) 
A. Arrange 
B. Picture Styles 

[C. Adjust] 
D. Styles 

9. What part of a chart give information about what the different colors and patterns 
represent ? (p. 67) 

A. brightness 
[B. legend] 

C. contrast 
D. color scale 

10. How can you format most parts of a chart? (p. 67) 
A. Choose Format>Chart. 
B. Choose Format>Legend 
C. Click the part of the chart that you want to change. 
[D. Double-click the part of the chart that you want to change.] 
 



LESSON 3 Practice It Activities 

1. Create a Custom Number Format, p. 73 
Solution The solution file for this activity is Soccer1-SF.xlsx. 

2. Use Conditional Formatting, p. 74 
New Student Strategy If a student did not complete Practice Activity 1, then the solution 
file for that activity can be used as a data file for this activity. 

Solution The solution file for this activity is Soccer2-SF.xlsx. 

3. Resize and Scale Graphics, p. 75 
New Student Strategy If a student did not complete Practice Activity 2, then the solution 
file for that activity can be used as a data file for this activity. 

Solution The solution file for this activity is Soccer3-SF.xlsx. 

 

LESSON 3 You Try It Activities 

4. Format a Chart, p. 76 
Solution The solution file for this activity is Party4-SF.xlsx. 

5. Customize a Graphic, p. 77 
Solution The solution file for this activity is Drama5-SF.xlsx. 



LESSON 3 Critical Thinking Activities, p. 78 
6. Beyond the Classroom Activity Answers will vary but may include highlighting the 
following information: videos that were rented over a week ago, customers who owe 
more than $30, or DVDs that cost more than $25. 
7. Standards at Work Activity The solution file for this activity is Contacts7-SF.xlsx. 
8. 21st Century Skills Activity The solution for this file activity is Quizzes8-SF.xlsx. 
 

LESSON 3 Challenge Yourself Projects, p. 79 

9 Identify Accounts  
LEVEL This is an intermediate level project. 

 Solution The solution file for Project 9 is Due9-SF.xlsx. 

 

10 Format Customer Numbers 
LEVEL This is an intermediate level project. 

 Solution The solution file for Project 10 is Due10-SF.xlsx. 

 

11 Customize a Column Chart 
LEVEL This is an advanced level project. 

Solution The solution file for Project 11 is Due11-SF.xlsx. 

NCLB/Math (Algebra) Reinforce the representation of data as a chart, graph, or diagram 
as an effective tool to visually convey information by having students go online to find 
examples to share with the class. 
 
Answers Rubrics for each Challenge Yourself Project and Before You Begin questions 
are available at www.glencoe.com. You may want to download the rubrics and make 
them available to students as they complete each project. 



LESSON 4 Advanced Collaboration, Lesson Opener, p. 80 
 21st Century Skills Answers will vary. Students should identify a method they use to 

track their progress toward a particular goal. If students do not track their progress toward 
this goal, encourage them to think of a way to do so. 

 

LESSON 4 Reading Guide, p. 81 
See page TM42 of the Teacher Annotated Edition for English Learner activity 

suggestions.  

 

EXERCISE 4-2 Set a Password to Open a Workbook, p. 84 
Step-By-Step Tip In Step 4, make sure students check to make sure that Caps Lock is 
not on when they key the password. Tell students to be very careful to key the password 
correctly. 
EL Make sure English Learners understand the meaning of case sensitive. A password 
such as Purple4U is case sensitive. The capital P and the capital U must be keyed in 
order for the password to work.  
Teaching Tip Microsoft Office allows you to protect your documents from unwanted 
access with a tool called Information Rights Management (IRM). IRM prevents 
unauthorized access, printing, or copying of sensitive information. While other 
permissions tools prevent or restrict access from within a network, IRM protects 
documents wherever they are by storing the permissions information inside the file. The 
Windows Rights Management Services (RMS) software is built in to Windows Vista. 
You must install RMS Client Service Pack 1 if you are using Windows XP. 
 

EXERCISE 4-3 Set a Password to Modify a Workbook, p. 85 
Step-By-Step Tip In Step 3, have students check to make sure Caps Lock is not on. 
Teaching Tip Give students suggestions about how to manage their passwords. Tell 
them to create a password that is easy for them to remember, but difficult for other people 
to guess. 
 

EXERCISE 4-4 Create a Shared Workbook, p. 86 
Different Strokes Tell students that the keyboard shortcut for Save As is F12. 
Troubleshooting Let students know that, typically, users share files on a network. 
Explain to students that they will open two copies on their computer to simulate this 
situation. 
 

EXERCISE 4-5 Use Track Changes, p. 87 
Differentiated Instruction/Visually Impaired If some students have trouble reading the 
worksheet, have them increase the zoom. 



 

EXERCISE 4-7 Copy a Worksheet, p. 90 
Step-By-Step Tip In Step 1, make sure students go back to the Museum file. They 
should not be working in the Museum-copy file. 

 

EXERCISE 4-8 Add and Modify Headers and Footers, p. 92 
Teaching Tip Explain to students that they can close headers and footers by clicking 
anywhere in their worksheet. Tell them that they can close headers and footers without 
keeping any of the changes that they made, by pressing ESC. 
Step-By-Step Tip In Step 8, tell students that they can also click the Normal button on 
the status bar to retun to Normal view.  
 

EXERCISE 4-9 Merge Workbooks, p. 93 
Intervention Strategy Make sure students understand why, in Figure 4.24, cell F18 is 
marked as changed, even though this change was later rejected. 
 

EXERCISE 4-10 Mark a Document as Final, p. 94 
Step-By-Step Tip In Step 5, make sure students undestand that the Mark as Final 
command is not a security feature. If a user receives a file that is marked as final, they 
can remove the Mark as Final status.  
 

EXERCISE 4-11 Use Digital Signatures to Authenticate Workbooks, p. 95 
Solution Use the files Museum-SF.xlsx, Museum-copy-SF.xlsx, and Original-data-
SF.xlsx as solution files for Exercises 4-1 through 4-11. The password to open the files is 
mystery7. 
 



MATH MATTERS Feature, Applying for a Business Loan, p. 96 

SkillBuilder Answers 
1. A business loan is a loan from a bank that enables someone to start or improve a 
business.  

2. Banks want to see if potential borrowers have failed to repay loans in the past. 

3. Allen will owe $6,000 in interest. 
NCLB/Math (Number and Operations) Make sure students understand how to figure 
out percentages. Percentages are expressed mathematically as decimals to the hundredths 
place. For example 8% = .08, while 80% = .80. 
 



LESSON 4 After Your Read, p. 97 

Answers to Review Vocabulary 
1. [Protect] a worksheet if you do not want people to be able to change it. (p. 82)  
2. To show that a workbook comes from a trusted source, you can attach a(n) [digital 

signature]. (p. 95)  
3. To allow several people to open and edit a workbook at the same time, [share] the 

workbook. (p. 86) 
4. If a file should only be opened by certain users, create a(n) [password]. (p. 84)  
5. When you use Track Changes, you can accept or [reject] changes made by other users 

in a shared workbook. (p. 88)  
 
Answer to Key Term Activity Protecting worksheets and workbooks help keep users 
from inserting, deleting, or changing data. Setting passwords helps prevent unauthorized 
people from opening the file. Adding a digital signature lets people know that the file is 
from a trusted source. If someone is deliberately trying to harm a file, these protections 
might not be effective. 
 
Answers to Review Key Concepts 
Answer the following questions on a separate piece of paper. 
7. Which elements can you protect? (pp. 82-83) 
A. A range of cells 
B. A worksheet 

C. A workbook 
[D. All of the above]

 
8. How could you prevent certain users from opening a confidential workbook? (p. 84) 
A. Add a digital signature. 
B. Protect the worksheet. 

[C. Set a password to open.] 
D. Enable Track Changes. 

 
9. What would you do to certify yourself as the sender of a file? (p. 95) 
[A. Add a digital signature.] 
B. Protect the worksheet. 

C. Set a password to open. 
D. Enable Track Changes. 

 
10. How can you prevent certain users from modifying a file? (p. 85) 
A. Create a digital signature. 
[B. Set a password to modify.] 

C. Enable worksheet protection. 
D. Enable workbook protection. 

 
 



LESSON 4 Practice It Activities 

1. Share a Workbook and Track Changes, p. 98 
Solution The solution file for this activity is Clubs1-SF.xlsx 

2. Accept and Reject Changes, p. 99 
New Student Strategy If a student did not complete Practice It Activity 1, then the 
solution file for that activity can be used as a data file for this activity. 
Solution The solution file for this activity is Clubs2-SF.xlsx 

3. Merge Workbooks, p. 100 
New Student Strategy If a student did not complete Practice It Activity 2, then the 
solution file for that activity can be used as a data file for this activity. 
Solution The solution files for this activity are Clubs3-SF.xlsx and Clubs3-copy-
SF.xlsx. 
LESSON 4 You Try It Activities 

4. Protect Formulas, p. 101 
Teaching Tip Ask students to explain in their own words why they can change some 
cells and not others. 
Solution The solution file for this activity is May4-SF.xlsx. 

5. Add a Digital Signature and Set a Password to Open a Workbook, p. 102 
Teaching Tip If new students did not create a digital signature earlier in the lesson, refer 
them back to Exercise 4-11. 
Solution The solution file for this activity is May5-SFxlsx. 
 
LESSON 4 Critical Thinking Activities, p. 103 
6. Beyond the Classroom Activity Student final files will vary, but should include two 
new rows of data that were added with Track Changes on. 
NCLB/Language Arts (NCTE 3) Reinforce the importance of tracking all changes in a 
document by asking students to come up with examples of what would happen if changes 
were not tracked. Have them share their answers with the class. Ask them why they think 
it would be necessary to share a workbook and protect it with a password at the same 
time. Explain to students that this would prevent others from turning Track Changes off. 
7. Standards at Work Activity Student files will vary, but their worksheets should be 
protected. The first appointment should be changed to 8:20. 
8. 21st Century Skills Activity Students’ files should require a password to open the 
files. 



 

LESSON 4 Challenge Yourself Projects, p. 104 

9. Protect an Expenses Worksheet 
 LEVEL This is an intermediate level project. 

Solution The solution file for Project 9 is Baseball9-SF.xlsx. 

 

10. Work Collaboratively 
LEVEL This is an advanced level project. 

NCLB/Language Arts (NCTE 5) Reinforce the difference between comparing and 
merging workbooks and consolidating data stored on different worksheets by having 
students share their answers with the class. 

Solution The solution file for Project 10 is Baseball10-SF.xlsx. 

 

11. Choose Which Changes to Keep 
LEVEL This is an advanced level project. 

Solution The solution file for Project 11 is Baseball11-SF.xlsx. 

 
Answers Rubrics for each Challenge Yourself Project and Before You Begin questions 
are available at glencoe.com. You may want to download the rubrics and make them 
available to students as they complete each project. 



LESSON 5 Advanced Data Management, Lesson Opener, p. 105 

 21st Century Skills Answers will vary. Students should say how well they adapt to 
new situations. Encourage students to consider how they could be more adaptable. 

 

LESSON 5 Reading Guide, p. 106 
See page TM42 of the Teacher Annotated Edition for English Learner activity 

suggestions.  

 

EXERCISE 5-1: Import Data to Excel, p. 107 
Intervention Strategy Check that students know where to locate and save their data 
files. 
 
EXERCISE 5-2 Link to Web Page Data, p. 108 
Troubleshooting Students must have Internet access to complete this exercise. 
Teaching Tip Have students AutoFit column A, if necessary. 
 

EXERCISE 5-3 Use the Document Inspector, p. 109 
Step-By-Step Tip In Step 2, explain to students that it is a good idea to use the 
Document Inspector on a copy of their original document because they might not be able 
to restore the data once the Document Inspector removes it from the file. 

Solution The solution file for this exercise is Deals-copy-SF.xlsx. 

 

EXERCISE 5-4 Add Information to Workbook Properties, p. 110 
Differentiated Instruction/Advanced Students Have students Choose Office>Open 
and then point to their Deals file. Explain to students that a ScreenTip appears showing 
the new properties. 
 

EXERCISE 5-5 Create and Edit a Workbook Template, p. 111 
Teaching Tip Explain to students that a template is similar to a job application. You are 
given a blank form that you fill in with your specific information. 

 
EXERCISE 5-5 Create and Edit a Workbook Template (Continued), p. 112 
Teaching Tip Explain to students that if they want to add something to a template, they 
can edit it. Tell students that the changes that they make to a template will affect all new 
workbooks created from the template. 



Solution Use the files Homes-SF.xltx and Bluehills-SF.xlsx as solution files for 
Exercises 5-1 through 5-5. 
 
EXERCISE 5-6 Save Workbooks As Previous Versions, p. 113 
Solution Use the files Bluehills-SF.xls and Downtown-SF.xls as solution files for 
Exercise 5-6. 
 

EXERCISE 5-7 Save a Workbook As a PDF, p. 114 
Troubleshooting To save or export a file to PDF or XPS, students will have to download 
and install the Save as PDF or XPS add-in for the 2007 Microsoft Office system. Go to 
the Microsoft Download Center online and follow instructions on how to download and 
install the add-in.  

Solution Use the file Downtown.pdf as the solution file for this exercise. 

 

EXERCISE 5-8 Save a Workbook As Macro-Enabled, p. 115 
Teaching Tip Ask students to identify a common task that requires a sequence of 
actions, such as tying their shoes. Ask them what it would be like if they could snap their 
fingers to complete this task. Explain that this is what a macro does, but for Excel tasks.  
 

EXERCISE 5-10: Run a Macro, p. 118 
Solution Use the file Downtown-SF.xlsm as a solution file for Exercises 5-8 through 5-
10. 
 

EXERCISE 5-11 Consolidate Data from Two or More Worksheets, p. 119 
Solution Use the file Paper-SF as a solution file for Exercise 5-11. 
 

MATH MATTERS Feature, Payroll Sheet, p. 120 

SkillBuilder Answers 
1. Net pay is the total amount earned (gross pay) minus taxes, Social Security, Medicare, 
and any other deductions.  

2. Answers will vary. Students may say that businesses need to know payroll expenses in 
order to budget their resources appropriately and keep track of taxes. 

3. Sandy’s net pay is $132.37. (17 × $9.50 – $29.13 = $132.37) 
NCLB/Math Make sure students understand how to figure out percentages. Percentages 
are expressed mathematically as decimals to the hundredths place. For example 8%=.08, 
while 80%=.80. 



LESSON 5 After You Read, p. 121 

Answers to Review Vocabulary 
1. The Document Inspector can help you remove sensitive information about a document 

that you would not want to [reveal], or show to a reader. (p. 109)reveal 
2. To transfer data from Excel to another application, [import] the data. (p. 107)  
3. A model worksheet ready to be filled in with new data is called a(n) [template]. (p. 

111)  
4. The author is one example of a workbook [property]. (p. 110)  
5. [Delimited] data are separated by a character such as a tab or comma. (p. 107)  
 
Answer to Vocabulary Activity PDF pages will vary, but all of them should include five 
vocabulary words and their definitions. 
 
Answers to Review Key Concepts 
Answer the following questions on a separate piece of paper. 
7. How do you record the title, author, and subject of a workbook? (p. 110) 
A. Save the file as a template. 
[B. Add workbook properties.] 

C. Import the data. 
D. Save the file as a Web page. 

 
8. How do you import data to Excel from a Web page? (p. 108) 
A. Save the file as a Web page. 
B. Consolidate the data. 

[C. Create a Web query.] 
D. Edit the template. 

 
9. What do you create when you consolidate, or combine data from multiple worksheets? 

(p. 119) 
A. Keyboard shortcut 
[B. Summary Worksheet] 

C. User-defined template 
D. Web query 

 
10. What feature allows you to record a series of commands that can be played back 

using a single command? (p. 116) 
A. Web query 
B. Compatibility Checker 

C. template 
[D. macro] 

 
 



LESSON 5 Practice It Activities 

1. Import Data in Excel, p. 122 
Solution The solution file for this activity is Trip1-SF.xlsx. 
 

2. Modify Workbook Properties and Save As a Previous Version, p. 123 
New Student Strategy If a student did not complete Practice Activity 2, then the solution 
file for that activity can be used as a data file for this activity. 
Solution The solution file for this activity is Trip2-SF.xlsx. 
3. Create and Modify a Template, p. 124 
Solution The solution files for this activity are Month3-SF.xltx and April3-SF.xlsx. 
 

LESSON 5 You Try It Activities 

4. Consolidate Data, p. 125 
Solution The solution file for this activity is Downtown4-SF.xlsx. 
5 Save a Workbook as a PDF, p. 126 
New Student Strategy If a student did not complete You Try It Activity 4, then the 
solution file for that activity can be used as a data file for this activity. 
Solution The solution file for this activity is Downtown5-SF.pdf. 
 

LESSON 5 Critical Thinking Activities, p. 127 
6. Beyond the Classroom Activity Students’ files should include the current stock 
quotes imported from the MSN Web page. 
NCLB/Language Arts (NCTE 7) Remind students to cite all their sources. Students 
should avoid plagiarism when they use research in their own work. 
7. Standards at Work Activity Students’ files should include the following file 
properties: subject, author, comments, and key words. 
NCLB/Language Arts (NCTE 5) Reinforce to students that the text they key into the 
document properties can be viewed by other users with access to the files. Comments 
should consist of brief, precisely worded language that employs parallel grammatical 
structure.  

8. 21st Century Skills Activity Students’ files should be based on their Quiz template. 
Files should include quiz scores and averages. 

 

LESSON 4 Challenge Yourself Projects, p. 128 

9 Set Up Your Supplies 
LEVEL This is an intermediate level project. 



Solution The solution files for Project 9 are Carwash9-SF.xlsx and adv-e5rev9-SF.xlsx. 
Students’ files will vary but should look similar to adv-e5rev9-SF.xlsx. 

 

10 Monitor Sales 
LEVEL This is an advanced level project. 

 Solution The solution file for Project 10 is adv-e5rev10-SF.xlsx. 

 

11 Find Total Sales 
LEVEL This is an advanced level project. 

Solution The solution file for Project 11 is Summer11-SF.xlsx. 

NCTM (Number and Operations) Reinforce the representation of numbers in formulas 
by having students create a workbook that consolidates the number of donations received 
by the school’s computer lab. Thanks to a donation from a local bank, the school has 
received a donation of 62 new desktop computers, 13 laptop computers, 7 printers, and 
40 flash memory drives. Ask students to create a workbook that has a separate sheet for 
each type of donation. Each sheet should include a column for the name of the donor. 
Then, ask them to create a summary sheet to total the number of donations.  

 

Answers Rubrics for each Challenge Yourself Project and the Before You Begin 
questions are available at www.glencoe.com. You may want to download the rubrics and 
make them available to students as they complete each project. 


